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Revision history 

 
Manual Rev. Software version Revisions Date 
13.10 Version V1.00.00.06 or higher  09.2010 
01.11 Version V1.01.00.00 or higher Software updates 02.2011 
02.12 Version V1.01.01.xx or higher Software updates 01.2012 
03.13 
 
 
 
 

Version V1.01.02.xx or higher 
 
 
 
 

New devices supported; 
Essential/Professional 
version; bug fixes; 
optimized database 
performance 

07.2013 
 
 
 
 

04.13 Version V1.02.00.xx or higher 
Split graphic to several 
pages for print-out;  
bug fixes 

12.2013 

05.14 Version V1.02.00.17 or higher 
Windows 8 support;  
bug fixes 

09.2014 

    

Version comparison 

The following table gives an overview on the different functions and features of the 
diverse versions of the Software:  

 
Function/Feature Essential version Trial version 

(restricted on  90 
days) 

Professional version 

Supported databases: 
 
 

 
 

 
 

Postgre SQLTM    

OracleTM    

Microsoft SQL ServerTM    

Supported devices:    

Ecograph RSG20    

Ecograph A RSG22    

Ecograph C RSG24    

Ecograph T RSG30    

Ecograph T RSG35    

Memograph RSG10    

Memograph S RSG12    

Memograph M RSG40    

EngyCal RH33    

EngyCal RS33    
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RA33    

Sampler    

User administration    

Several accesses to the database 
from various PCs at the same time 
possible 

   

Data of more than one device 
inside a template 

   

Automatic readout    

Automatic deletion    

Automatic binary export     

Automatic XLS/CSV export     

Automatic PDF export     

Export ready for eSight (Energy 
Monitoring Software) 

   

Import of ReadWin® 2000 data    

 

A change from the Essential version and the trial version to the Professional version is 
possible at any time by entering a valid license key. The license key can be entered in the 
dialog box “Change/activate license” under the main menu “Help”. 

In the same menu the overview on the differences between the various versions can be 
seen at any time (“License information”).  

Please note that the trial version is automatically turned into an Essential version after 
the 90 days have elapsed unless no upgrade by entering a license key is done. Since 
certain functions then won’t be available anymore, e.g. created templates with data of 
more than one device and also automatic exports won’t work anymore.   
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1 Introduction 

1.1 Preface  

The Reporting Software package offering central data management and visualization of 
stored data. This allows complete documentation of the data from a measuring point, e.g.: 

• measurement values 

• diagnostics events 

• protocols 

The evaluation software stores data in a SQL database. The database can be operated 
either locally or in a network (client /server). 

Note! When using the Essential version, a database stored in the network cannot be 
accessed simultaneously by multiple PCs. 
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1.2 Notes on safety conventions and icons  

The safety instructions in these Operating Instructions are labeled with the following 
safety icons and symbols: 

 

! Note! 

This symbol indicates an action or procedure which, if not performed correctly, can have 
an indirect effect on operation or trigger an unexpected response on the part of the 
device. 

 

" Caution! 

This symbol indicates an action or procedure which, if not performed correctly, can 
result in incorrect operation of the software or device. 

 

1.3 Safety instructions  

Observe the following points: 

 The manufacturer accepts no liability for damages resulting from incorrect use or use 
other than that designated. 

 Observe all safety instructions in the Operating Manuals for the devices connected to 
the system. 

 Installation, commissioning, operation and maintenance of the measuring system 
must be carried out by trained, skilled personnel authorized to perform such work by 
the facility's owner-operator. The skilled personnel must have read and understood 
these Operating Instructions and follow the instructions they contain. 

1.3.1 Disclaimer of liability  

This software and the corresponding documentation can be revised or updated by the 
manufacturer without prior notice. In case of a revision or update, the end user has no 
claim to automatic delivery free of charge of the revised or updated software or the 
corresponding documentation. 

It is at the manufacturer's discretion to decide whether or not a revision or update of the 
software is carried out, and when. 

The documentation includes the printable version of the Operating Manual and brief 
operating instructions. The printable version of the Operating Manual is valid for the 
version specified on the cover sheet. The version number of the currently installed 
version is provided in the Help menu item. 

The manufacturer disclaims all liability for any damage resulting directly or indirectly 
from the use of this software and the corresponding documentation. This does not 
include cases of malicious intent or gross negligence. 

In case of simple negligence, the manufacturer shall be liable only to the extent to which 
an obligation was not fulfilled, the fulfillment of which is essential to attaining the 
objective of the contract (material obligation). In this case, the manufacturer shall be 
liable only for the foreseeable damages typical of the contract and only up to an amount 
equal to 5 times the price of the software.  

Likewise, there is no warranty that this software will function on all hardware platforms 
or in conjunction with other software. We exclude all further claims due to any damages 
that occur. 
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1.4 Hardware and software requirements 

The following requirements must be met before installing and operating the PC software:  

1.4.1 Hardware: 

 PC with PentiumTM 4 (≥2 GHz),  

 PC with PentiumTM M (≥1 GHz), 

 PC with AMDTM (≥1,6 GHz) 

 Minimum 512 MB RAM Cache 

 Minimum 1 GB free drive space 

 Screen with minimum 1024 x 800 pixel 

 CD ROM drive 

 

1.4.2 Software: 

 MicrosoftTM WindowsTM 2000 SP4  

 MicrosoftTM WindowsTM 2003 Server R2 SP2 Standard, Enterprise (32 Bit)  

 MicrosoftTM WindowsTM 2008 Server (32/64 Bit) 

 MicrosoftTM XP SP2 (32 Bit)  

 MicrosoftTM VistaTM (32/64 Bit)  

 Windows 7TM (32/64 Bit) 

 Windows 8TM (32/64 Bit) 

 WindowsTM .NET 2.0 SP1 
 

1.4.3 User rights for Installation 

 Logged in user rights: WindowsTM Administrator 

 User Account Control (UAC) confirmation when activated   

1.4.4 Changes during installation: 

1. FdmUser user profile added (Database access) 

2. Installation directory added 

3. Files copied to installation directory 

4. Application directory added 

 WindowsTM 2000: %systemdrive%\Documents and Settings\All 
Users\Application Data\Endress+Hauser  

 WindowsTM XP: %systemdrive%\Documents and Settings\All 
Users\Application Data\Endress+Hauser  

 WindowsTM Server 2003: %systemdrive%\Documents and Settings\All 
Users\Application Data\Endress+Hauser  

 WindowsTM Vista, WindowsTM 7, WindowsTM 8 and Windows ServerTM 
2008: %systemdrive%\ProgramData\Endress+Hauser 

5. WindowsTM .NET 2.0 SP1 installed (optional) 

6. Field Data Manager Windows Service (FDM WS) installed (autorun, 
optional) 
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7. Field Data Manager Tray Icon Application (FDM TI App) installed (autorun, 
optional) 

8. PostgreSQLTM Server installation (optional) 

9. Program shortcut created 

10. Registry entries 

11. Installation log file created (%tmp%)  

1.4.5 Components 

1.4.5.1 FDM TI App running with logged in user privileges 

Read and write access to following directories (since version 1.01.01.06): 

 Installation directory 

 Application directory 

 Mapped network drives (optional) 
 

1.4.5.2 FDM WS running with Local System Account 

Read and write access to following directories (since version 1.01.01.06): 

 Installation directory 

 Application directory 

 Mapped network drives (optional) 

1.4.5.3 FDM application running with logged in user privileges 

Read and write access to following directories (since version 1.01.01.06): 

 Installation directory 

 Application directory 

 %tmp%  

1.4.6 Firewall 

 Used field device communication port (default: TCP port 8000, incoming/ outgoing) 

 Microsoft SQLTM database server (default TCP 1433, incoming/ outgoing) 

 PostgreSQLTM database server (default TCP 5436, incoming/ outgoing) 

 OracleTM database server  (default TCP 1521, incoming/ outgoing) 

 LDAPTM network service (optional, default: TCP/UDP port 389, incoming/ outgoing) 

 Network printer (optional) 

1.4.7 User 

See 1.4.5 Components 

1.4.8 UAC 

No special permissions necessary after installation (except the FDM user will start/ stop 
the FDM WS). 
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1.5 Installation 

Note!  
You will find a detailed description of installation in the enclosed short manual. 

 Insert the CD. 

 If autostart is enabled, the installation is started automatically; otherwise 

 Start "Setup.exe" directly from the CD. 

 Follow the instructions of the installation program. 

If you confirm the installation of the automatic component, an additional Windows 
system service is set up. This system service enables you to trigger and control automatic 
actions through the Reporting Software. These include, for example, automatic reading 
out of devices, automatic printing of reports, and automatic report generation. The 
system service is active only when automatic tasks are enabled and scheduled (see Chap. 
4.4, Automatic).  

 

The following data bases are supported: 
The Reporting Software stores the data in a SQL database. The database can be installed 
locally or in a network (Client/Server). Following data bases are supported: 

• PostgreSQLTM (for Essential, Demo and Professional version) 

You can use the PostgreSQL database provided on the Reporting Software CD. 
With the Reporting Software you can install and use the free of charge PostgreSQL 
database. To do this no manual installation and configuration is necessary. The database 
is configured automatically during the installation of the Reporting Software. 
 
 
• OracleTM (for Demo and Professional version) 

Version 8i or higher. Please contact your system administrator if the Reporting Software 
will be used with an Oracle database server. The necessary steps for the installation you 
will find in the enclosed short manual. 
 

• Microsoft SQL ServerTM (for Demo and Professional version) 

Version 2005 or higher. Please contact your system administrator if the Reporting 
Software will be used with an Oracle database server. The necessary steps for the 
installation you will find in the enclosed short manual. 

1.5.1 Software update/upgrade  

You will find a detailed description in the enclosed short manual. 

1.6 Starting the program, selecting the operating language  

Under "Start -> Programs", you will find the newly installed "Field Data Manager Software" 
program. Start the program and, if necessary, change the operating language under 
"Extras -> Settings -> Language". The changed operating language is applied after the 
program is restarted.  
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1.7 Quick launch, switchover from ReadWin® 2000  

Note!  
In contrast to ReadWin® 2000, the Reporting Software does not support device 
configuration.  

All the readout functions of ReadWin® 2000 have been merged into the "Data readout" 
task in the Reporting Software. Here, the data can be read out via an interface - i.e. 
connected to the device online - or via a data storage medium.  

In addition, the functions for displaying the read-out data have been merged into one 
"Visualization" task in the Reporting Software. It is possible to select the display mode (bar 
graph – histogram, line chart or table) and visualize the data directly via the chart settings 
or channel settings (as users will know from Excel for example). This means that 
individual channels can be displayed differently in a single chart. 

Funktionen in ReadWin® 2000 im Gegensatz zur neuen Auswertesoftware: 

 

 

In the Reporting Software, the device settings (communication, automatic functions) are 
configured via the plant tree structure by right-clicking the device or directly in the 
individual visualization steps or when reading out the device data. 

As with ReadWin® 2000, the settings for configuring the automatic function are grouped 
in one point under "Data Management –> Automatic“. 

The automatic function is set up as a system service and runs in the background. The 
Reporting Software does not necessarily have to be started to run an automatic task. 

 

1.8 Taking over the "Plant View" from FieldCare  

To take over the Plant View from FieldCare, you have to first export the view from 
FieldCare or save it as a CSV file. For this purpose, FieldCare gives you the ability to export 
the Plant View in CSV format via "File -> Import/Export -> Export as CSV" and to store it at 
a location to be defined. This device tree can then be taken over in the Reporting Software. 

The Reporting Software gives you the ability to take over an existing, saved device tree or 
an existing Plant View from another program (e.g. FieldCare). This functionality is 
provided in the task "Data Management -> Plant View". 

Pressing the "Box with arrow"  icon opens the menu structure of the computer. Select 
the storage location and the corresponding CSV file of the Plant View. Then, the tree 
structure is read into the database and stored there. The same functionality is provided by 
selecting the Enterprise, then right-clicking and selecting "Import Plant View" (see Chapter 
4.1 Data Management -> Plant View  ). 

Note! As the Essential version does not support all devices, only data from supported 
devices can be imported in this version! 
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1.9 Data import from ReadWin® 2000  

Note! The transfer of data from ReadWin® 2000 is not supported in the Essential version! 

To import data from ReadWin® 2000 to the SQL database of the Reporting Software in a 
tamper-proof manner, the process begins with the secure data export from ReadWin® 
2000. For this purpose, the data for the corresponding devices are exported to a storage 
medium or drive (Extras -> Store/save measured values): 

 

 
 

 
 

Subsequently, the data of the individual devices are imported into the SQL database via the 
import function of the Reporting Software. For this purpose, select the data format rsd. 
See the description of the import function in Chapter 4.3 on page 60. 
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1.10 The main Docking Area  

The following picture shows the general design of the Reporting Software. However the 
application will use different icons and menu entries: 

 

 

1.10.1 Main Menu  

The main menu at the top contains the menu bar with function groups for the settings: 

File -> Program end 

View -> Settings of the display 

Extras -> Settings of database, language, user administration, audit trail 

Help -> Online help, software information, change/activate license 

1.10.2 Main Toolbar  

The main toolbar at the dockable window allows quick access to common functions like 
print, save or the online help. 

1.10.3 Task Pane  

On the left hand side is the task pane. A closed task pane can be made visible again with 
“View” in the main menu. By clicking on a task the contained functions are displayed: 

Read out data -> read out data of a mass storage or online connection to the device 

Visualization -> Visualization template new, open or delete 

Data management -> open plant view, export or import of device data 

1.10.4 Main window  

The main docking area is component which contains dockable windows. When more than 
one dockable window is docked, tabulators are shown. Docked windows can be undocked 
by dragging the header.  
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1.10.5 Dockable window  

A dockable window can be docked in the main docking area or can “fly” outside the frame. 
It is possible to position the window one other screens without blocking other windows. 
The frame of the window contains a button for close (X) on the right.  
Every dockable window has a header area (on top of the window) with the name of the 
sub item on the left side and the icon of the sub item on the right side. Below the header a 
toolbar is shown which provides window specific icons, tooltips and functionality. Below 
the tool bar starts the main component area for the dockable window. 

1.10.6 Status Bar  

The Status Bar shows the login state and other information.  

1.10.7 Splitter  

The Splitter separates the task pane and the main docking area. The splitter can only be 
operated when task pane and main docking area are visible. A change of this position 
enables resizing of the task pane and main docking area. The mouse cursor changes to the 
resize symbol, when it is over the splitter border.  

 

2 Task pane -> Read out data 

Read out data and store them to the database – "Read out data" 

By selecting the task "Read out data" from the task pane, you can carry out the 
configuration, read out measurement data or other data stored in the device and 
simultaneously store the data to a database so that they are tamper-protected.  

As the target database, you can use the PostgreSQLTM  database supplied free of charge 
with the Reporting Software or other existing SQL database (OracleTM  and Microsoft SQL 
ServerTM). For the settings for selecting the database, refer to Chapter 5.1.2. 

Note! The Essential version supports only the free PostgreSQLTM database provided. 

In the "Read out data" task, the two types of readout, "Mass storage" or "Online Connection", 
are available.  

Clicking the corresponding icon opens an additional working window in the right half of 
the screen. This window guides you step-by-step through the items to be defined.  

Icons in the upper area help you navigate through the individual steps: 

  Green arrow pointing left: corresponds to the "Back" button; jump to the previous 
definition step. 

  Green arrow pointing right: corresponds to the "Next" button; jump to the next 
definition step. 

  Question mark: Help; call up the help function for the corresponding definition 
step. 
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2.1 Read out data -> Mass storage 

In this task, you can read out and store data (binary *.dat) from storage media such as SD 
cards, USB sticks etc. 

2.1.1 Step 1 of 3: Select Data Source  

Where are the data to be read in stored? 

Select the data source. 

The "…" button opens the menu structure of the computer. 

The drop-down menu suggests storage locations and storage media that were already 
used earlier: 

 

 

After selecting the data source or storage location of the data to be read in, you can jump 
to the next step using "Next". 

Clicking "Cancel" terminates this action, closes the window and stops the process. 
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2.1.2 Step 2 of 3: Select Device  

From which device are the data to be read in? 

In this second step, the corresponding devices and their time range of the data are 
selected: 

 

 

The "Devices" area lists the devices found on the storage medium. 

There, you can select a device or devices by checking them. This means that you do not 
have to read out the entire data volume of the storage medium. 

You can select them all using the "Select all" button. "Unselect all" removes the selection. 

Checking the box for "Delete files after import" deletes the selected data from the storage 
medium as soon as these have been stored successfully to the database.  

Caution! Once data are deleted from the storage medium, this cannot be undone! 

When you have finished selecting the devices to be read out, define the volume of data to 
be stored. This data is then read out in the next step. 

Finish your selection by pressing "Next". 

You can return to the previous view by selecting "Back".  

Clicking "Cancel" terminates this action, closes the window and stops the process. 
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2.1.3 Step 3 of 3: Reading Data  

The defined data are read out and stored to the database. 

A progress bar shows the progress in % and displays the estimated time remaining. The 
duration of the read-out process depends on the data volume and the storage medium 
used. Clicking "Cancel" terminates this action, closes the window and stops the process. 

The read-out process is finished when a prompt to close the wizard appears: 

 

Click "Close" to finish the task and close the window. 

The data defined in steps 1 and 2 have now been read in from the storage medium 
successfully and stored to the database. 
If, in step 2, a check mark was set next to "Delete files after import", the stored data will 
now have likewise been successfully deleted from the storage medium.  
Caution! This step cannot be undone. 
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2.2 Read out data -> Online Connection 

2.2.1 Read data from online interface already created  

2.2.1.1 Step 1 of 5: Select Device 

From which device do you want to read out? 

Note! Not all devices are supported in the Essential version. Unsupported devices which 
have already been installed are displayed along with their configuration. However, the 
available functionality cannot be applied to them. 

You can select the device to be read out in step 1.  
The view shows the already created Plant View. This view can be restructured and 
expanded (see 4.1 Data Management -> Plant View ). 

 

The "Memory card in device" and "Device memory" buttons are used to select the device data 
to be read out.  
"Memory card in device": The data on the memory card of the selected device are read out. 
"Device memory": The data in the internal memory of the selected device are read out. 

The selected data will be deleted automatically from the device memory or from the 
memory card as soon as these have been stored successfully to the database.  
Caution! Once data are deleted, this cannot be undone! 

You can activate an immediate readout by right-clicking and then selecting "Read out data" 
or by selecting "Next". Then, step 5, "Read out data", opens. 

Reading out via a communication interface requires a defined communication with the 
device. The communication can be configured or modified via data management, when 
creating devices in the Plant View, or in this step. 

Selecting the device and right-clicking, then selecting "Configure interface..." opens the 
Communication Settings: 
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Clicking "Cancel" terminates this action, closes the window and stops the process. 

2.2.1.2 Step 2 of 5: Configure Online Interface  

Step 2 is skipped automatically, as the device settings are already stored in the saved 
device. 

2.2.1.3 Step 3 of 5: Configure Automatic  

Step 3 is skipped automatically, as the automatic configuration is already stored in the 
saved device. 

2.2.1.4 Step 4 of 5: Device Information  

If "Readout memory card in device“ is selected in step 1: 
The software tests the connection to the device and loads the specific device information. 
The data which are contained on the memory card and which can be individually selected 
for readout are displayed: 

 

To modify the selected device or the communication specifications, you can return to the 
previous steps via "Back". 

Clicking the "Next" button activates reading out of data from the device. 
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Clicking "Cancel" terminates this action, closes the window and stops the process. 

If "Readout device memory“ is selected in step 1: 
Step 4 is skipped automatically, and all data are read out from the device memory. 

 

2.2.1.5 Step 5 of 5: Read out data  

The defined data are read out and stored to the database. 

A progress bar shows the progress in % and displays the estimated time remaining. The 
duration of the read-out process depends on the data volume and the storage medium 
used. Clicking "Cancel" terminates this action, closes the window and stops the process. 

The read-out process is finished when a prompt to close the wizard with "OK" appears: 

 

The defined data have now been read in from the storage medium successfully and stored 
to the database. The stored data will now have likewise been successfully deleted from the 
device memory or memory card.  
Caution! Once data are deleted, this cannot be undone! 

Click "Close" to finish the task and close the window. 
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2.2.2 Reading out a new device not yet created  

2.2.2.1 Step 1 of 5: Select Device or create new device 

The view shows the already created Plant View. This view can be restructured and 
expanded (see 4.1 Data Management -> Plant View ).  

If the device to be read out is not yet created, you can create a new device using the "New 
Device" button. Pressing this button jumps to step 2. 

 

 

Clicking "Cancel" terminates this action, closes the window and stops the process. 
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2.2.2.2 Step 2 of 5: Configure Online Interface 

In step 2, the new device to be created and read out is defined. 

To do so, define the interface to the device, the device type and the memory type for data 
read out (Device memory, Memory card in device) in the "Select source" area. 

Automatic device detection: In the case of automatic device detection, the device type is 
automatically detected when the required interface parameters are specified. Automatic 
detection is enabled as standard. If automatic device detection is disabled, a drop-down list 
of all supported device types appears once the interface is specified.  

Then, in the lower area, define the communication/interface in greater detail. 

 

Checking the box for "The device is read out by more than one Reporting Software" enables 
data readout from more than one PCs (max. 4). 

Checking the box for "Repeat export periodically" enables a regular automatic readout. You 
can define the automatic function for the corresponding device in the next step or via the 
automatic configuration 6.3). The automatic readout requires a continuous connection to 
the device. 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step.  
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2.2.2.3 Step 3 of 5: Configure Automatic  

Note! This is possible only if "Repeat export periodically" has been enabled in the previous 
step. 

 

Data read out: 
The regularity of the automatic function is defined here. For this purpose, the "Active" 
check box must be selected. 
Interval: How often does the export take place? 
Depending on the selected interval, define the repetition, Start day and Start time (see 
Chapter 6.3). 

Time synchronize: 
Here, you can synchronize the device time with the system time of the computer. 
To define the regularity of the synchronization, the "Active" check box must be selected 
(see Chapter 6.5).  

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step.  
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2.2.2.4 Step 4 of 5: Device Information 

This tests the communication defined for the device. 
The software tests the connection to the device and loads the specific device information. 

In addition, if "Readout memory card in device“ is selected (in step 2), the data which are 
contained on the memory card and which can be individually selected for readout are 
displayed: 

 

 

To modify the selected device or the communication specifications, you can return to the 
previous steps via "Back". 

Clicking the "Next" button activates reading out of data from the device. 

The selected data will be deleted automatically from the device memory or from the 
memory card as soon as these have been stored successfully to the database.  
Caution! Once data are deleted, this cannot be undone! 

 

Clicking "Cancel" terminates this action, closes the window and stops the process. 
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2.2.2.5 Step 5 of 5: Read out data 

The defined data are read out and stored to the database. 

A progress bar shows the progress in % and displays the estimated time remaining. The 
duration of the read-out process depends on the data volume and the storage medium 
used. Clicking "Cancel" terminates this action, closes the window and stops the process. 

The read-out process is finished when a prompt to close the wizard appears: 

 

 

The defined data have now been read in from the storage medium successfully and stored 
to the database. The stored data will now have likewise been successfully deleted from the 
device memory or memory card.  
Caution! Once data are deleted, this cannot be undone! 

Click "Close" to finish the task and close the window. 



3 Task pane -> Visualization 

 26 

3 Task pane -> Visualization 

In the Task pane, the task "Visualization" includes all items that pertain to the display of 
the stored data. 

Basically, the two functions "New" or "Open" are available. 

The "New" function creates a new visualization. By clicking "Open", visualizations/templates 
that have been defined earlier and stored are available. 

Templates can be deleted with the "Delete templates" function. 

Clicking the corresponding icon opens a working window in the right half of the screen. 
This window takes you step-by-step through the process for displaying the stored data in 
the desired variant. 

Icons in the upper area help you navigate through the individual steps: Icons in the 
working window that are grayed out are not available for the corresponding work step. 

  Green arrow pointing left: corresponds to the "Back" button; jump to the previous 
definition step. 

  Green arrow pointing right: corresponds to the "Next" button; jump to the next 
definition step. 

  Question mark: Help; call up the help function for the corresponding definition 
step. 

Note! 
In the Essential version, templates can be created, displayed and edited only if they 
contain data from devices supported by this software version! Only one device can be 
assigned in each case to the templates! 
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3.1 Visualization  -> New  

3.1.1 Step 1 of 4: Select Devices  

In step 1, the source devices are selected. On the left side of the working window, you can 
see the Plant View (see 4.1 Data Management -> Plant View ). This view lists all devices 
for which you can visualize the data. 

Note! 
Only the supported devices can be selected in the Essential version!  
No more than one device can be selected! 

The right side of the working window shows the summary of the selected devices: 

 

You can select a device for the visualization by checking the device in the Plant View and 
clicking or double-clicking the blue arrow that appears. 

If you want to delete a device from the list of selected devices later, select it in the right-
hand list, then double-click the checked device or click the blue arrow that points towards 
the left to remove it from the list. 

If at least one device has been selected, the "Next" button appears. Click this button to jump 
to the next step. 

Clicking "Cancel" terminates this action, closes the window and stops the process. 
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3.1.2 Step 2 of 4: Select Channels  

In step 2, select the analyses and channels of the source devices: 

 

Functions: 

Trend: 
Measurement values: Instantaneous values (analog values) of the selected device can be 
selected. 

Reports:  
Day, Week, Month, External (selection possible only if these analyses are stored in the 
device). 

Channels: 
Device Designation/TAG, Device Type: This shows information about the selected device.  
Min, Max, Average, Instantaneous: Select the analog values of the device. 
Status: Select the digital values of the device. 

After selecting the analyses and channels for the data to be visualized, you can jump to the 
next step using "Next". 

Clicking "Cancel" terminates this action, closes the window and stops the process. 

You can return to the previous view by selecting "Back".  
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3.1.3 Step 3 of 4: Select Time Slot or Batch 

In step 3, select the Time Slot (or the Batch, if available) of the data to be visualized: 

 

After selecting at least one time slot for the data to be visualized, you can jump to the next 
step using "Next".  
Note! A maximum of 3 identical time ranges can be selected and thus compared to each 
other. 

Clicking "Cancel" terminates this action, closes the window and stops the process. 

You can return to the previous view by selecting "Back".  



3 Task pane -> Visualization 

 30 

3.1.4 Step 4 of 4: Chart 

Step 4 displays the Graph, Values and Events of the selected Time Slot: 

 

 

The following functions of the icons are possible:  

 Floppy disk: Save the visualization; if it has not yet been saved, a new template is 
created. The template is then available for future visualizations. 

 Floppy disk with pen: Save as; create a new template, assign a new name for the 
template. 

  Box with arrow: Export; gives you the ability to export the selected data in the 
*.csv or *.xls formats. 

  Printer icon: Print; allows you to print the current window. 

  Adobe Acrobat® icon: Export as PDF file. 

  Bar Chart: Change chart settings: 
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  Pin: Enable or disable value cursor. If you move the mouse pointer over the chart, 
the displayed value is automatically updated below the graph according to the 
position of the mouse pointer. By pressing the left mouse button, the displayed values 
in the "Values" and "Events" area are also updated. 

  Notepad: Add comment; enables you to add comments in the chart area, this 
option is available for the chart view exclusively. 

  Magnifying glass+: Zoom In 

  Magnifying glass-: Zoom Out 

  Magnifying glass 1:1: Reset zoom 

  Gear with printer: Automatic print out 

  Gear with Excel: Automatic ExcelTM/ CSV Export 

  Gear with Adobe Acrobat® icon: Automatic PDF Export 

  Rectangle with blue arrow: Maximize or minimize the chart 

Note! The "Automatic print out“, "Automatic ExcelTM /CSV export“ and "Automatic PDF 
export“ functions are not supported in the Essential version and therefore cannot be 
selected. 

"Graph" area: 
Double-clicking the header in the "Graph" area enlarges the graphic view and shows it in 
full-screen mode. The function corresponds to the "Maximize the chart" icon. This enables 
you to work more conveniently without additional scrolling effort: 

 

The note "Reduced data volume" means that the data have been reduced automatically to 
compile the chart. This enables a fast display. If you zoom into the chart (multiple times), 
this note no longer appears, as all values must be used for the display.  
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You can left-click to draw a frame in the chart field. This enables you to enlarge the 
selected area: 

 

Left-clicking a text line in the legend (right) opens a window with additional chart 
settings: 

 

 



3 Task pane -> Visualization 

 33 

"Values" range: 
Display all values with timestamp. You can select "Search" to search values of a certain 
day/time.  

If the cursor is enabled, by pressing the left mouse button the displayed values are 
updated according to the position of the mouse pointer in the diagram: 

 

 

“Program Logbook” area: 

With selected data of a sampler there is an additional area with the Program Logbook. It 
contains all completed sample programs of the selected time period. Beside the area 
header 'Program Logbook' is a "Document" button:  
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After selection of a sample program it can be opened with the "Document" button and 
afterwards saved and printed: 

 

Click "Close" to finish the task and close the window. 

 

"Events" area: 
Events of the selected device are shown here.  

If the cursor  is enabled, by pressing the left mouse button the displayed events are 
updated according to the position of the mouse pointer in the diagram: 

 

 

"Close" stops the visualization and the window closes. 

You can return to the previous view by selecting "Back".  
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3.2 Visualization  -> Open 

3.2.1 Step 1 of 4: Select Template 

In step 1, you can select the template of the data to be visualized: 

 

If a template has been selected, the "Next" button appears. Click this button to jump to step 
3. 

Note! 
In the Essential version, templates can be selected and opened only if they contain data 
from devices supported by this software version! Templates with more than one device 
cannot be opened! 

Clicking "Cancel" terminates this action, closes the window and stops the process. 

 

3.2.2  Step 2 of 4: Select Channels 

Step 2 is skipped automatically, as the analyses and channels of the source devices are 
already stored in the selected template. 
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3.2.3 Step 3 of 4: Select Time Slot or Batch 

In step 3, select the Time Slot (or the Batch, if available) of the data to be visualized: 

 

After selecting at least one time slot for the data to be visualized, you can jump to the next 
step using "Next".  
Note! A maximum of 3 identical time ranges can be selected and thus compared to each 
other. 

Clicking "Cancel" terminates this action, closes the window and stops the process. 

You can return to the previous view by selecting "Back".  

 

3.2.4 Step 4 of 4: Chart 

Step 4 displays the Graph, Values and Events of the selected Time Slot (for descriptions, 
refer to Chapter 3.1.4).  
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3.3 Visualization -> Edit Template 

3.3.1 Step 1 of 4: Select Template  

You can edit and delete stored templates here: 

 

By selecting the template and right-clicking, you can delete or rename the selected 
template. 

If one template has been selected, the "Edit" button appears. Click this button to jump to 
the next step. 

Note! 
In the Essential version, templates can be selected and edited only if they contain data 
from devices supported by this software version! Templates with more than one device 
cannot be edited! 

Clicking "Close" terminates this action, closes the window and stops the process. 
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3.3.2 Step 2 of 4: Select Device  

In step 2, the source devices are selected. On the left side of the working window, you can 
see the Plant View (see 4.1 Data Management -> Plant View ). This view lists all devices 
for which you can visualize the data. 

The right side of the working window shows the summary of the devices in the 
visualization template: 

 

You can select a device for the visualization by checking the device in the Plant View and 
double-clicking or clicking the blue arrow that appears. 

If you want to delete a device from the list of selected devices later, select it in the right-
hand list, then double-click the checked device or click the blue arrow that points towards 
the left to remove it from the list. 

Note! 
Only supported devices can be selected in the Essential version!  
No more than one device can be selected! 

If at least one device has been selected, the "Next" button appears. Click this button to jump 
to the next step. 

Clicking "Cancel" terminates this action, closes the window and stops the process. 
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3.3.3 Step 3 of 4: Select channels  

In step 3, select the analyses and channels of the source devices: 

 

Functions: 

Trend: 
Measurement values: Instantaneous values (analog values) of the selected device can be 
selected. 

Reports:  
Day, Week, Month, External (selection possible only if these analyses are stored in the 
device). 

Channels: 
Device Designation/TAG, Device Type: This shows information about the selected device.  
Min, Max, Average, Instantaneous: Select the analog values of the device. 
Status: Select the digital values of the device. 

After selecting the analyses and channels for the data to be visualized, you can update the 
selected template using "Update". 

Clicking "Cancel" terminates this action, closes the window and stops the process. 

You can return to the previous view by selecting "Back".  
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3.3.4 Step 4 of 4: Updating template 

Step 4 updates the selected template. 

A progress bar shows the progress in % and displays the estimated time remaining.  

If the process is finished successfully, a confirmation text appears: 

 

You can edit further templates by selecting “Step 1”. 

Click "Close" to finish the task and close the window. 
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4 Task pane -> Data Management 

The task "Data Management" includes all functions that pertain to the management of 
data and devices.  

The data are managed by importing data (e.g. in insecure format as *.csv or *.xls or in 
secure format as *.fdm). The data can also be relocated from the database to reduce the 
volume of the database. 

The device management takes place primarily via the Plant View, i.e. the tree structure in 
which all available devices are listed. 

4.1 Data Management -> Plant View   

You can open the Plant View via the task "Data Management -->Plant View". 

Before you can create devices, one Enterprise must be present (is already defined as a 
default setting). The entire Enterprise can then be divided into Site, Area, Process Cell and 
Unit. 

This division results in a tree structure with multiple nodes. You can assign multiple 
devices to each node: 

 

Note! 
Not all devices are supported in the Essential version. Only devices supported by this 
software version can be assigned to the nodes. 

The Main Toolbar of the Plant View gives you the following options: 

 

  "Plus": Add a new node, i.e. further subdivide the structure of the enterprise; the 
hierarchy is the sequence of Enterprise, Site, Process Cell, Area. Devices can be 
assigned to these nodes. These device nodes can also be renamed, deleted or moved 
to other plant areas (other higher-level nodes). 

  "Cross": Delete a selected node, a device or data in the database. When deleting 
device data the time range can be selected:  
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Caution! When you delete a node, the corresponding allocated subnodes and the 
devices assigned to these nodes are deleted along with all of the data. 

  "Scissors": Cut out the selected node and copy it to the clipboard. You can then 
reinsert the node by pasting it at another location in the Plant View. 

  "Clipboard": Paste a node copied to the clipboard earlier 

  "Pad with pen": Rename the selected node 

  "Rings": Merge data (see Chapter 4.1.1) 

  "Box with arrow": Import an existing Plant View / device tree (e.g. from FieldCare) 
(see Chapter 1.8) 

  "Wrench": Open the Communication Settings of the selected device (see Chapter 
6.1) 

  "Two arrows": Load the Plant View from the database; this function is needed in 
order to update the Plant View (e.g. after creating a new device during the first read-
out process). 

The options listed above (creating, deleting, renaming nodes; merging data; etc.) are also 
available in the context menu that appears when you right-click.  

 

Creating a new device: 

The read-out process for a new device creates a new device node in the Plant View. The 
readout can take place via the interface or from the storage medium (see Chapter 2). The 
data are analyzed while they are read out. If the read-out device is already stored in the 
database (with serial number and device designation/TAG and the same device 
configuration) the data are automatically assigned to the corresponding device node and 
thus to the known device. If there are deviations of the read-out device in the serial 
number or device designation/TAG, a new device node is created automatically. If the 
serial number and device designation/TAG do not deviate, but the configuration was 
changed between the last read-out process and the current read-out process, a new 
configuration node is created for the data under the existing device node. The read-out 
data are then assigned to this new configuration node. 

 

Importing an existing Plant View/existing device tree: 

The Reporting Software gives you the ability to take over an existing, saved device tree or 
an existing Plant View from another program. This functionality is provided in the task 
"Data Management -> Plant View". 

Pressing the "Box with arrow"  icon opens the menu structure of the computer. Select 
the storage location and the corresponding CSV file of the Plant View. Then, the tree 
structure is read into the database and stored there. The same function is provided by 
selecting the Enterprise, then right-clicking and selecting "Import Plant View". 
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Device settings: 

Settings that are assigned directly to a corresponding device can be defined using the 
setting menu in the Plant View. 

To do so, select the corresponding device, then open the settings window by selecting the 

"Wrench" symbol   or by right-clicking and selecting "Change settings ..." from the 
context menu. For a detailed description, see Chapter 6. 

 

4.1.1 Merge Configurations  

Individual read-out devices are identified in the Reporting Software via device 
designation/TAG and serial number. In addition, the configuration of the channels is 
evaluated. 
If the read-out data can be clearly assigned to a device (via the serial number and device 
designation/TAG) but the configuration of the read-out device data does not match the 
stored device configuration, a new configuration is created below the device node. 
This can happen, for example, if the configuration of the device has been changed (e.g. a 
channel has been switched off or the unit of a channel has been changed) or the device 
has been used as a portable measuring instrument at different measuring points with a 
different configuration. 

If you want to merge data despite a different configuration, to ensure a continuous 
database and thus a continuous analysis, you can do so using the "Merge Configurations" 
function. 

When merging, the measuring data are always assigned to the latest, most recent 
configuration. 

Select a configuration in the Plant View in the task "Data Management -> Plant View" 4.1. 
This selected configuration is then assigned the data of the other configurations, i.e. the 

selected configuration remains in place. Clicking the "Rings" icon  or the context menu 
that appears when you right-click "Merge Configurations" opens a new dialog window: 

4.1.1.1 Step 1 of 2: Select Configurations  

The left side displays the devices available in the database and their assigned 
configurations. 
By double-clicking a configuration, selecting the configuration and clicking the arrow that 
points to the right in the center of the two boxes or dragging and dropping using the 
mouse, you can move the configurations to be merged to the right side. 

All data of these configurations in the right-hand box are merged and assigned to the 
configuration selected in the Plant View and the corresponding device.  
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Pressing the "Next" button or the green arrow in the Main Toolbar jumps to step 2 and 
merges the configurations.  
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4.1.1.2 Step 2 of 2: Merging  

It is only possible to merge configurations if no data are lost as a result of the merge. 
Example: A device has 2 configurations. 2 channels were active in the older configuration 
while one channel was switched off in the more recent configuration. As a result of the 
merge, all the data are assigned to the latest (more recent) configuration. In this example, 
only one channel would now be active. It would not be possible to access the data of the 
second channel. For this reason, in our example it is not possible to merge the 
configurations. In such situations a message is displayed. 
Other situations can, however, occur in which the user can decide whether the 
configurations are to be merged or not. An example would be changing a unit of a channel 
or switching a channel from average to minimum. A message is displayed here, e.g.: 

 

Select the appropriate button to either merge the configurations or cancel the merge. 

A progress bar shows the progress in % and displays the estimated time remaining. While 
the data are merging, you can stop the action at any time by pressing the "Cancel" button. 

 

After the data are merged successfully, a confirmation appears below the progress bar. 
Caution! Once devices and device configurations are merged, this cannot be undone! 

Click "Close" to finish the task and close the window. 



4 Task pane -> Data Management 

 46 

4.1.2 Merge Devices  

Individual read-out devices are identified in the Reporting Software via device 
designation/TAG and serial number. 

If devices do not match in these points, they are created as separate devices in the Plant 
View. 

For replacement devices/spare devices, you are prompted to merge the data despite the 
different serial numbers to ensure a continuous database and thus a continuous analysis. 
The "Merge Devices" function gives you the ability to do this. 

You can select one of the devices to be merged in the Plant View in the task "Data 
Management -> Plant View" 4.1. The selected device remains, and all data of the devices 

to be merged are assigned to this selected device from now on. Clicking the icon  or 
the context menu that appears when you right-click "Merge Devices" opens a new dialog 
window:  

4.1.2.1 Step 1 of 2: Select Devices  

The left side stores the devices available in the database. 
By double-clicking a device, selecting the device and clicking the arrow that points to the 
right in the center of the two boxes or dragging and dropping using the mouse, you can 
move the devices to be merged to the right side. 
All data of these devices in the right-hand box are merged and assigned to the device 
selected in the Plant View.  

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to step 2 and 
merges the data of the devices.  
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4.1.2.2 Step 2 of 2: Merge Devices Result   

A progress bar shows the progress in % and displays the estimated time remaining. While 
the data are merging, you can stop the action at any time by pressing the "Cancel" button. 

Caution! Once devices are merged, this cannot be undone! 

After the devices and their data are merged successfully, a confirmation text appears: 

 

Click "Close" to finish the task and close the window. 

 

4.2 Data Management -> Export 

You can export the data stored in the database. 
Various options exist for doing so: 

- Tamperproof export in a secure format (binary files *.fdm) 

- Export in insecure formats (ExcelTM / CSV) 

Data that are exported in the secure format cannot be modified. This enables you to 
securely relocate the data to reduce the data volume in the database or to transfer data to 
another database or another user so that they are secured against tampering. 
If data in the secure format are read back into the Reporting Software, they are treated the 
same as original data. 
If data in the ExcelTM or CSV format are stored, these are identified as manual data. 

The differentiation of the type of export takes place in the first step via the selection of the 
file type/format. 
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4.2.1 Export in a secure format (binary files, *.fdm)  

To export data, the export function under "Data Management –> Export" is used. The 
export in the secure format takes place in 6 steps: 

4.2.1.1 Step 1: Select Export Format  

You can choose between binary files (*.fdm), Excel (*.xls), CSV files (*.csv) or CSV for 
Energy Monitoring files (*.csv). 

To export in the secure format, select “Binary files (*.fdm)” here: 

 

Note about export for energy monitoring: 

Data for energy monitoring are exported in a non-protected format (*.csv) with specially 
matched properties (column limit, date and time format are set by default). To import 
measured values of the Reporting Software to the energy monitoring software, you have to 
enter an import code there. The import code is composed of <channel name>-<type>, i.e. 
the combination of the first two cells in each column. 
Example: Analog 1-average or Analog 2- 

Note! 
A "CSV for energy monitoring files (*.csv)“ export is not supported in the Essential version. 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step.  
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4.2.1.2 Step 2 of 6: Select Device  

The left side shows the devices available in the database. 

By double-clicking a device, selecting the device(s) and clicking the arrow that points to 
the right in the center of the two boxes or dragging and dropping using the mouse, you 
can move the device(s) to be exported to the right side. 

You can export the data of the device on the right side. 

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step.  

4.2.1.3 Step 3 of 6: Select Time Slot  

You can define a time range using the drop-down lists provided. All stored data of the 
selected devices that lie within this time range are exported. 

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step.  
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4.2.1.4 Step 4 of 6: Select File Name and File Size  

Output file: 
File name: You can define the storage location here. Clicking the "..." button opens the 
menu structure of the computer and selects the storage location for the export. 

Maximum File Size: To limit the size of the export file or adapt it to the medium of the 
target storage location (such as DVD, CD), you can select the target medium using the 
drop-down list: 

 

Beneath that, two additional functions are offered: 

Repeat Export Periodically: 
Automatic export and automatic relocation of data in secure format. Enabling/checking 
this check box activates an automatic function for export.  

Delete data after successful export: 
Enabling this check box deletes the successfully exported data from the database. This 
means that the data are no longer available in the Reporting Software, but only as a secure 
export file. 

Caution! Once data is deleted from the database, this cannot be undone! If you want the 
data to be available later for analyses or visualizations, this data exported in the secure 
format has to be reimported to the Reporting Software. 

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step.  
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4.2.1.5 Step 5 of 6: Configure Automatic  

Note! This is visible only if "Repeat readout periodically" has been selected in the previous 
step. 

 

Data backup: 
The regularity of the automatic export is defined here. For this purpose, the "Active" check 
box must be selected. 

Interval: How often does the export take place? 
Depending on the selected interval, define following points, such as repetition, Start day 
and Start time. 

Start / Data time period: This selects the time range for export. This means that the export 
at the defined time point contains the data of the selected time range, beginning at the 
start date/time of export and going back (see Chapter 6.6). 

File Path: If a network drive is selected a user and password request is prompted. The 
current setting will be saved and can be changed under “Extras -> Settings -> Automatic” 
(see chapter 5.1.6). 

Caution!  In order to allow the Automatic access to the network drive the logon of the 
Automatic service has to be adjusted (see chapter 5.1.6)  

Data elimination: 
Caution! Once data is deleted from the database, this cannot be undone! Ensure that data 
that are deleted from the database are really no longer needed, or have already been saved 
to another storage location as a secure export so that they are available later if needed. 

This configures the automatic function for deleting the data from the database. If you 
selecting the "Active" check box, exported data are deleted irretrievably from the database 
(see Chapter 6.4).  

Caution! Before confirming the "Next" button, please check the selection you have made: 
Do you really want to delete the data? Do the automatic export function and automatic 
deletion overlap? Have you ensured that the data are not deleted before the secure export? 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step, 
starts the export, deletes the data and starts the automatic function (if selected). 
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4.2.1.6 Step 6 of 6: Exporting Data  

A progress bar shows the progress in % and displays the estimated time remaining. While 
the data are exporting, you can stop the action at any time by pressing the "Cancel" button.  

After the data are exported successfully, a confirmation appears below the progress bar. 

 

Click "Close" to finish the task and close the window. 
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4.2.2 Export in insecure format (ExcelTM/CSV, Energy monitoring)    

To export data, the export function under "Data Management –> Export" is used. The 
export into an insecure format (ExcelTM/CSV) takes place in 8 steps: 

4.2.2.1 Step 1 of 8: Select Export Format  

To export in the insecure format, select “Excel (*.xls)”, “CSV files (*.csv)” or “CSV for 
Energy Monitoring files (*.csv)” here: 

 

Note about export for energy monitoring: 

Data for energy monitoring are exported in a non-protected format (*.csv) with specially 
matched properties (column limit, date and time format are set by default). To import 
measured values of the Reporting Software to the energy monitoring software, you have to 
enter an import code there. The import code is composed of <channel name>-<type>, i.e. 
the combination of the first two cells in each column. 
Example: Analog 1-average or Analog 2- 

Note! 
A "CSV for energy monitoring files (*.csv)“ export is not supported in the Essential version. 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 
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4.2.2.2 Step 2 of 8: Select Usage of Template  

Here, you can select which data are exported: 

 

Do not use templates: 
If the following device and channel selection is to be valid for export only, and the report 
to be defined is needed for other automatic actions (automatic visualization/automatic 
print out), you can select the "Do not use a template" option here. 

Create new template: 
If you want to define a new template, you can select the "Create new template" option here. 
In this case, the template is also available for later visualizations. Templates represent 
predefined reports with preselected devices and channels.  
Using the "Template Name" line, you can assign a new name for the template to be created. 
Only after a name is defined can you jump to the next step. 
You cannot use names that have already been assigned, as in this case the existing 
template would be overwritten. If you want to change an existing name of a template to 

identify it uniquely, you can do so in the box using the "Pad with pen" icon  or by right-
clicking and selecting "Rename" from the context menu. 

Open Template: 
If a report to be generated has already been defined as a visualization and stored as a 
template, you can select the template (which already contains the corresponding devices 
and channels) here. 

Note! 
In the Essential version, templates can be selected only if they contain data from devices 
supported by this software version! Templates containing more than one device cannot be 
edited! 

 

If you want to make changes in the device or channel selection, you can do so by clicking 
the "Back" button or the corresponding green arrow icon in the Main Toolbar. 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 
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4.2.2.3 Step 3 of 8: Select Devices  

Note! This step is skipped if you use an existing template. 

The left side displays the devices available in the database and their configurations. 
By double-clicking a configuration, selecting the configuration and clicking the arrow that 
points to the right in the center of the two boxes or dragging and dropping using the 
mouse, you can move the devices to be exported to the right side. 
You can export the data of the devices on the right side. 

 

Note! 
Only supported devices can be selected in the Essential version!  
No more than one device can be selected! 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 
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4.2.2.4 Step 4 of 8: Select Channels  

Note! This step is skipped if you use an existing template. 

The left side displays the active channels of the selected devices/configurations. You can 
select the corresponding channels by selecting the check boxes. 

You can select all active channels by selecting the check box of the configuration (of the 
respective higher-level check box). 

 

Functions: 

Trend: 
Measurement values: Instantaneous values (analog values) of the selected device can be 
selected. 

Reports:  
Day, Week, Month, External (selection possible only if these analyses are stored in the 
device). 

Channels: 
Device Designation/TAG, Device Type: This shows information about the selected device.  
Min, Max, Average, Instantaneous: Select the analog values of the device. 
Status: Select the digital values of the device. 

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 
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4.2.2.5 Step 5 of 8: Select Time Slots or Batch  

You can define a time range (or Batch, if available) using the drop-down lists provided. All 
stored data of the selected devices that lie within this time range are exported. 

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 
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4.2.2.6 Step 6 of 8: Select File Name  

You can define a storage location in the "Output file" box. Clicking the "..." button opens the 
menu structure of the computer and selects the storage location for the export. 

Data: Selection whether just Values and/or Events shall be exported. 
 

 

Repeat Export Periodically: 
Automatic export and automatic relocation of data in insecure format. Enabling/checking 
this check box activates an automatic function for export.  

Note! 
Automatic export and automatic relocation of data in an insecure format are not 
supported in the Essential version. 

(Note! "Repeat Export Periodically" is possible only when using a template. See step 2 of 8) 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 
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4.2.2.7 Step 7 of 8: Configure Automatic  

Note! This is visible only if "Repeat Export Periodically" has been selected in the previous 
step. 

In the box "Excel/CSV Export", you can define the regularity (repetition rate) of the 
automatic export. For this purpose, the "Active" check box must be selected. 

Interval: How often does the export take place? 
Depending on the selected interval, define following points, such as repetition, Start day 
and Start time. 

Data time period: This selects the time range for export. This means that the export at the 
defined time point contains the data of the selected time range, beginning at the start 
date/time of export and going back (see Chapter 6.6). 

Export type: Selection whether just Values and/or Events shall be exported.  

File handling: Selection whether the export file shall be newly created, attached to the 
existing file or whether the existing file shall be overwritten. 

File Size: In order to restrict the size of the export file or to adjust it to the medium of the 
storage location (such as DVD, CD) the target medium can be selected in the drop-down 
list.  

File Path: If a network drive is selected a user and password request is prompted. The 
current setting will be saved and can be changed under “Extras -> Settings -> Automatic” 
(see chapter 5.1.6).   

Caution! In order to allow the Automatic access to the network drive the logon of the 
Automatic service has to be adjusted (see chapter 5.1.6). 

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step 
and starts the export and the automatic function (if selected). 



4 Task pane -> Data Management 

 60 

4.2.2.8 Step 8 of 8: Exporting Data  

A progress bar shows the progress in % and displays the estimated time remaining. While 
the data are exporting, you can stop the action at any time by pressing the "Cancel" button.  

After the data are exported successfully, a confirmation appears below the progress bar. 

 

Click "Close" to finish the task and close the window. 

 

4.3 Data Management -> Import  

The Reporting Software gives you the ability to import data into the database. 
These data can be provided by devices as well as files. 
For this purpose, you have the option of importing data that were previously exported in 
the secure format using the *.fdm format. This format ensures that data are tamper-
protected and thus are genuine measured data. 

A data transfer from the ReadWin® 2000 PC software is possible via rsd format (see 
chapter 1.9). 

Note! 
The transfer of data from ReadWin® 2000 is not supported in the Essential version! 

You also have the ability to import data from ExcelTM (*.xls) or CSV files (*.csv). 
This can be used for planning data, for example. This enables you to carry out direct 
comparisons of planning data and actual measured data. 
Data imported in XLS or CSV format are identified as manual data. 
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Import format for ExcelTM (*.xls) or CSV (*.csv) files: 
If data is to be imported in the reporting software using ExcelTM or CSV, the values 
(measurements, channel names etc.) must be entered into corresponding file. It is 
important that the timestamp cell contains the format (e.g. YYYY-MM-dd hh:mm:ss). 

When formatting the timestamp cell ISO 8601 must be taken into account. The dash "-" is 
defined as the hyphen for day, month, year. 

Example: 

 
Time format  
(YYYY-MM-dd hh:mm:ss) Channel 1 Name Channel 2 Name Channel 3 Name Channel 4 Name … 

 Channel 1 Unit Channel 2 Unit Channel 3 Unit Channel 4 Unit … 

2000-11-23 23:48:34 0.0002 0.01 12 2778  

2000-11-23 23:48:35 0.345 0.03 24 56456  

2000-11-23 23:48:36 0.0688 0.05 36 110134  

2000-11-23 23:48:37 0.1031 0.07 48 163812  

2000-11-23 23:48:38 0.1374 0.09 60 217490  

2000-11-23 23:48:39 0.1717 0.11 72 271168  

 

 

4.3.1 Step 1 of 3: Select Source  

You can define a storage location for the data in the "Select Source" box. Clicking the "..." 
button opens the menu structure of the computer and you can select the file to be 
imported. 

If you select a file in the secure format (*.fdm), step 2 is skipped, as the devices to be 
imported have already been defined by the format. 

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 
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4.3.2 Step 2 of 3: Select Device  

Select a device or a node in the Plant View. The data to be imported are then assigned 
organizationally to this plant section: 

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step 
and starts the import. 

 

4.3.3 Step 3 of 3: Importing Data  

A progress bar shows the progress in % and displays the estimated time remaining. While 
the data are imported, you can stop the action at any time by pressing the "Cancel" button.  

After the data are imported successfully, a confirmation appears below the progress bar. 

 

Click "Close" to finish the task and close the window. 
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4.4 Data Management -> Automatic  

Configuring the automatic function for the device: 

The automatic function is set up as a system service and runs in the background. Before 
you can activate an automatic function, you have to install the automatic component 
during the initial installation of the Reporting Software. If the automatic component is 

installed, the   icon appears on the bottom right border of the 
window. If this icon is not present, the component has to be installed. This is available on 
the installation CD (see Chapter 1.5). 

Note! 
Only automatic readout, automation deletion of data in the device following successful 
readout as well as automatic binary export are supported in the Essential version. The 
"Automatic Xls/Csv export", "Automatic Pdf export" and "Automatic print out" functions are 
not available in this software version. 

 

4.4.1 Automatic Information: Current overview  

All the automatic functions are organized in the "Data Management –> Automatic" task. In 
addition, the task also provides an overview of all the active or inactive automatic 
processes. 

Note! The automatic functions defined in the individual steps are still valid and can also be 
managed via the central task described here. 

 

4.4.1.1 Step 1 of 3: Job Type selection  

 

Automatic Information: Select the desired information  
Selection: Current overview, Event view, Automatic new/edit. 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 

 

4.4.1.2 Step 2 of 3: Select device / Select template  

Step 2 is skipped automatically. Selection for the automatic overview not required.  
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4.4.1.3 Step 3 of 3: Automatic overview  

An overview of all the automatic tasks is provided in Step 3: 

 

The individual automatic task can be enabled or disabled here. 

Color code: 
Orange: Automatic task is disabled 
White: Automatic task is enabled and ready for execution 
Green: Automatic task is currently being executed 
Blue: Automatic task is selected and can be deleted by clicking "X" in the tool bar. 
Red: Status of the automatic service is unknown (error, e.g. automatic function 
uninstalled) 

Clicking "Close” stops the process and closes the window. 
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4.4.2 Automatic Information: Event view  

All the automatic functions are organized in the "Data Management –> Automatic" task. In 
addition, the task also provides an overview of all the active or inactive automatic 
processes. 

Note! The automatic functions defined in the individual steps are still valid and can also be 
managed via the central task described here. 

 

4.4.2.1 Step 1 of 3: Job Type selection  

 

Automatic Information: Select the desired information  
Selection: Current overview, Event view, Automatic new/edit. 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 

 

4.4.2.2 Step 2 of 3: Select device / Select template  

Step 2 is skipped automatically. Selection for event overview not required.  
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4.4.2.3 Step 3 of 3: Automatic event overview  

An event overview of all the automatic tasks is provided in Step 3: 

 

Clicking “Close” stops the process and closes the window. 

 

4.4.3 Automatic new/edit  

All the automatic functions are organized in the "Data Management –> Automatic" task. In 
addition, the task also provides an overview of all the active or inactive automatic 
processes. 

Note! The automatic functions defined in the individual steps are still valid and can also be 
managed via the central task described here. 

 

4.4.3.1 Step 1 of 3: Job Type selection  

 

Automatic Information: Select the desired information  
Selection: Current overview, Event view, Automatic new/edit. 
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Select task (only possible at selection “Automatic new/edit”): 

o Read out device: The data stored in the field devices are automatically saved to the 
database. 

o Binary export: Is used for secure data export from the database, e.g. to relieve the SQL 
server. 

o Time synchronize: For regular, automated time synchronization, i.e. the time of the 
device is synchronized with the system time. 

o Delete data: Makes it possible to automatically delete data from the database.  
Caution! Once data are deleted from the database, this action cannot be undone!  

o Print out template: Makes it possible to automatically print out a visualization template 
at regular intervals, i.e. a report/visualization that has been defined is saved as a 
template and is regularly regenerated automatically and printed out.  

o Xls / CSV export: Makes it possible to automatically export data to xls or csv format at 
regular intervals. A template must also be selected here, i.e. a report that has been 
defined is saved as a template and is regularly regenerated automatically and exported.  

o Pdf export: Makes it possible to automatically export data to pdf format at regular 
intervals. A template must also be selected here, i.e. a report that has been defined is 
saved as a template and is regularly regenerated automatically and exported.  

o Web export: enables the automatic, regular export of data to other systems via the 
Endress+Hauser Middleware. A template must also be selected here. This means that if 
a report is defined it is saved as a template and the data are automatically sent to the 
Middleware on a regular basis. 

Note! 
Only automatic readout, automation deletion of data in the device following successful 
readout as well as automatic binary export are supported in the Essential version. The 
"Automatic Xls/Csv export", "Automatic Pdf export" and "Automatic print out" functions are 
not available in this software version. 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 
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4.4.3.2 Step 2 of 3: Select device / Select template  

Note! Only possible if step 1 is “Automatic new/edit”. 

In Step 2, the appropriate template or the device to be read out must be selected. 

 

 

Pressing the "Next" button or the green arrow in the Main Toolbar jumps to the next step. 
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4.4.3.3 Step 3 of 3: Settings automatic functions  

Note! Only possible if step 1 is “Automatic new/edit”. 

The frequency is defined in Step 3. For this purpose, the "Active" check box must be 
selected: 

 

You can then define the frequency using the interval and the start time (see Chapter 6.6). 

A data time period also has to be defined for the automatic tasks "Delete data," "Create pdf", 
"Csv export", "Xls export" and "Binary export" (secure format). 

File handling (in case of Excel/Csv export): Selection whether the export file shall be newly 
created, attached to the existing file or whether the existing file shall be overwritten. 

File Size (in case of Excel/Csv export): In order to restrict the size of the export file or to 
adjust it to the medium of the storage location (such as DVD, CD) the target medium can 
be selected in the drop-down list. 

File Path: The location of the data report to be exported must be defined for all export 
automatic tasks. Clicking the "..." button opens the My Computer / Explorer tree. 
If a network drive is selected a user and password request is prompted. The current setting 
will be saved and can be changed under “Extras -> Settings -> Automatic” (see chapter 
5.1.6). 

Caution! In order to allow the Automatic access to the network drive the logon of the 
Automatic service has to be adjusted (see chapter 5.1.6).  

Timeout (s) (for web export): timeout for the transmission of data to the Middleware. 
User name / password (for web export): user that is configured in the Middleware. 
Web URL (for web export): web address of the Middleware. 
Certificate (for web export): if communication with the Middleware is to take place via 
https (encrypted connection), the corresponding certificate for the automatic service must 
be available permanently. 
Connection test (for web export): to test the connection to the Middleware. 

Clicking "Save" enables, saves and completes the configuration. 
Clicking "Close” stops the process and closes the window. 
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4.4.4 Automatik Service:  

The Reporting Software shows in the right lower corner the state of the automatic 

windows service . This state will be modified by the state of the 
automatic windows service which can be: „Pending‟, „Paused‟, „Stopped‟, „Uninstalled‟, 
„Inactive‟, „Unknown‟ or „Running‟. 

States: 
 „Pending‟: The windows service is locked and waits for unblocking. If this state does 

not change during a time span e.g. 2 minutes. Please call your system administrator 
and restart the windows service. 

 „Paused‟, „Stopped‟: The windows service currently does not run. This can happen 
when the system administrator forces the service to pause. 

 „Uninstalled‟: The Reporting Software can be installed without automatic components. 
All settings within the Reporting Software are disabled when the automatic isn‟t 
installed. If you like to install these automatic components retry the setup routine and 
enable installation with automatic components (see Chapter 1.5). 

 „Inactive‟: The user can activate/ inactivate the internal state of the processed 
automatic jobs through the Tray Icon Application (see Chapter 4.4.5).  

 „Running‟: The windows service is running. 

 „Unknown‟: This state can appear when the database connection is not available or the 
windows service is in an undefined state. Please firstly try to restart the Reporting 
Software or secondly all automatic components and call your system administrator if 
this message does not disappear.         

Once an automatic service is started it remains active until is stopped manually, for 
example via the Tray Icon (see Chapter 4.4.5). 
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4.4.5 Tray Icon   

The „Tray Icon Application‟ is a small application which will be started automatically 
during system startup. When the application is started it shows an icon in the „Windows 

Menu Bar‟ .  
A localized context menu is shown when the user executes a right mouse click on this icon: 

 

Every time the automatic service is busy the tray icon app changes its icon .  
The standard icon will be shown when the automatic service is idle.  

 

Reporting Software: 
The first entry has a child entry to start and stop the Reporting Software: 

 

 

Automatic: 

 

At the next entry the Automatic function can be activated or deactivated. Activation is 
only possible, if the windows service is running „Extras -> Settings -> Automatic‟ (see 
Chapter 5.1.6). 
As you can see the child automatic menu shows all available automatic service jobs. With 
all this entries you can set single and multiple service jobs active or inactive. When a job is 
inactive it won‟t be executed by the automatic service.  
Every time you see this context menu the „Tray Icon‟ application synchronizes the state of 
the automatic jobs with the automatic service.  
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Log File: 
The „Event‟ entry opens the log file (WindowsServiceLog.txt) which will be filled by the 
„Automatic Service‟. The log file is located in: 
WindowsTM 2000 / XP: “C:\ Documents and Settings\AllUsers\ApplicationData\ 
Endress+Hauser\FieldDataManager ” 
WindowsTM VISTATM and higher: “C:\ProgramData\Endress+Hauser\FieldDataManager” 

 

Log off: 
On active user administration the user is also requested to log on for the Tray icon 
application. Only then is the function available. Once the user is logged on, no further 
check is carried out unless the user has logged off using the "Log off" function. The log-on 
for the Tray icon is independent from the log-on for the reporting software. 

 

Exit: 
The „Close‟ entry closes the „Tray Icon Application‟ but not the automatic windows service. 

 

When you don‟t like the automatic start up of the „Tray Icon Application‟ go to the 
Reporting Software at „Extras -> Settings -> Automatic‟ and change the settings (see 
Chapter 5.1.6). When the user administration is enabled within the Reporting Software, 
you also will be forced to log in before the context menu of the „Tray Icon Application‟ is 
shown.  
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5 Extras menu 

5.1 Extras -> Settings 

Here, you can configure general settings for the database, language, export format and 
user administration. 

5.1.1 Language  

You can select the languages available in the Reporting Software via the drop-down menu. 

If you change the language setting, the change does not take effect until after the software 
is restarted. 
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5.1.2 Database  

In the database settings allow you to select the database used or the corresponding SQL 
server.  
You can configure detailed, user-defined settings using the box in the bottom section of 
the dialog window. To do so, you can assign the server name and port number for existing 
databases and configure a timeout for automatic disconnection. 
If a certain username and password is required for an existing SQL server, this information 
can also be entered here. 

 

Note!  Only the PostgreSQL™ database is supported in the Essential version! When using 
the Essential version, a database stored in the network cannot be accessed simultaneously 
by multiple PCs. 

5.1.3 Export 

Configure the export formats. For descriptions, refer to the chapter 4.2 "Data Management 
-> Export": 
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5.1.4 User administration  

Activate the security system via the user administration if you want to protect the unit 
against unauthorized operation. After the initial installation of the Reporting Software, 
the user administration is disabled by default. 

Basic user administration settings are available in the "Extras –> Settings –> User 
Administration" menu: 

 

The user administration can be enabled in the settings. If enabled, the first user is 
automatically assigned the role of administrator. 

In addition to enabling the User Administration, you can define the corresponding 
requirements are defined that must be fulfilled by the passwords. 

To comply with the more stringent documentation and security requirements of FDA21 
CFR Part 11, this function must also be enabled. 
As a result of this function, the user has to identify himself or herself with a user ID and 
password whenever carrying out an action that affects the database (such as creating 
templates, creating or changing devices/device settings, deleting devices, etc.). 

The administration of users takes place in the function "Extras –> User Administration" 
(see Chapter 5.3). 

Note! User administration can be enabled only in the Professional and Demo versions! 
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5.1.5 Printer  

The printout format is defined in the Printer menu. If a logo is to appear on the printout, 
this can be selected and defined via the "Change Logo" button. 

You can define the font using the drop-down list: 

 

The following menu window opens once the printer icon  is operated in the reporting 
software e.g. visualization: 

 

Here the required printer, the print layout and settings can be selected. Additionally a 
print preview is also possible. 

In the visualization printer settings, you can select if the print-out is to be line-based or 
column-based. The column-based layout is enabled as standard. The line-based layout is 
enabled only for templates which contain analyses. 
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5.1.6 Automatic  

Note! If user administration is enabled, an administrator must be logged on before these 
automatic task settings can be changed. 

The "Automatic" menu contains start and stop functions for Windows System Service and 
for the Tray Icon Application. In addition, you can also define whether these functions 
should be started automatically here:  

 

Network Login Identity: In order to logon to a remote computer and get access to the 
directory, the Automatic needs a user and a password. This user must have the respective 
rights for the selected directory.  

Caution! In order to allow the Automatic access to the network drive the logon of the 
Automatic service has to be adjusted: 

1. Open Service 'Endress+Hauser FDM Service': “Control Panel -> System and security  
-> Administrative Tools -> Services” - double click 'Endress+Hauser FDM Service': 
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2. Change to “Log On”. Create a user with respective rights under “This account”: 

 

Save the settings with “Apply” and “OK”. 

3. The Service must be restarted in order to activate the new settings. 

 

5.1.7 General  

In the General menu items, readout with extended service function can be enabled. If this 
is enabled, a field appears in the readout. There is the option of not deleting data in the 
device once the data have been read out successfully. 

 

 



5 Extras menu 

 79 

5.2 Extras –> Audit Trail 

The Audit Trail function offers complete documentation with display of all actions carried 
out of the Reporting Software and the corresponding database. 

Any action that has an effect on the database is documented in the audit trail with the 
time stamp and user name (when User administration is enabled). This includes, for 
example, the following functions: create a new device, read out data, create template, user 
logs in, user logs out, report is generated, etc. 

In the Audit Trail, you can search for certain entries using the filter (Time, Text, User, 
Category). 

You can print out the Audit Trail using the printer icon . 

The  icon allows you to export the Audit Trail as a PDF file. 

 

Clicking “Close” stops the process and closes the window. 
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5.3 Extras -> User Administration   

Note! User administration can be enabled only in the Professional and Demo versions! 

The administration of users takes place in the function "Extras –> User Administration". 
This menu item can be accessed by administrators only. The administrator can create up to 
50 users. Once a user is created, he or she appears in the overview in the left box: 

 

Add User: 

You can add new users using the "Person with plus sign" icon . 

User ID: For each user, the administrator has to assign a unique User ID. Max. 8 characters 

Password, password confirmation: For the initial login of the user, the administrator has 
to assign a password. Max. 10 characters  

Selecting the "Password must be changed after first login" function ensures that the new 
user has to change the first password he or she is assigned: 

 

When logging in for the first time, the user must enter the password assigned by the 
administrator at the first login and assign a new password. 

Access role: You can assign various access roles to the user. These define the scope of user 
and access rights. 
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The following overview defines the rights for the individual user roles: 

 

Responsibility Admin. Service 
Engineer 

Planning 
Engineer 

Maintenance 
Engineer 

System 
Operator 

Observer 

Create new plant X  X    

Create new subnodes X  X    

Create new devices X  X X X  

Move plant nodes and 
devices 

X  X    

Rename devices X  X X   

Import topology from 
FieldCare CSV 

X  X    

Read out data X  X X X  

Export data X  X X   

Import data X  X X   

Import secure data 
(manipulation proof) 

X  X X X  

Export secure data  X  X X   

Use Layout / View data / 
print data / PDF, CSV, 
Excel out of visualization 

X  X X X X 

Create/change/delete 
automatic actions / device 
specifics 

X  X X   

Start / Stop automatic 
actions 

X  X X X  

Assign data / merge X  X X   

Delete data X  X X   

Option dialog: Language 
settings 

X  X X X X 

Option dialog: Export 
settings 

X  X X   

Option dialog: User 
password settings 

X      

User administration X      

Show audit trail log X X     
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Edit User: 

Using the "Person with pen" icon , you can modify the information about the user and 
reset the password. The dialog for changing the user information corresponds to the 
settings for creating a new user: 

 

The "Deactivate user" function enables you to block a user temporarily. In this case, a lock 
icon for "Locked" appears in the user overview. 

If the user enters incorrect information multiple times when logging in, the user also 
shows up as locked. The administrator can remove the lock by resetting the password. The 
user can then change the password again. 

 

Delete User: 

The "Person with red X" icon  allows you to delete a user marked in the list. Before the 
user is deleted, you are prompted for additional confirmation in a dialog window. If you 
confirm the deletion of the user, the corresponding account is deleted immediately. 

 

User rights for plant sections: 

In addition to the assignment of the user role, you can limit access to additional devices or 
plant sections. The assignment of the user rights for devices and plant sections takes place 
in the overview in the right-hand box: 
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By selecting the user in the list, you can give this user defined access to individual devices 
and plant sections. In doing so, the administrator selects a node. This gives the user access 
to the corresponding node (e.g. Plant, Area etc.) and to all assigned subnodes. 

If a user does not obtain access to certain plant sections or devices (node is not selected), 
these plant sections or devices are also not visible to the corresponding user in the Plant 
View. 

 

Access rights to templates: 
The access rights to templates are defined via the corresponding devices. A user has access 
to a template only if he or she has access to the corresponding devices. 

Access rights to devices: 
Access rights to devices are defined in the user administration via the Plant View. If a user 
is the first to create and read out a device, the user who carries out the readout 
automatically obtains access rights to this device. 

Login as user: 
The user logs in with his or her User ID and password. These are case-sensitive. When 
logging in for the first time, the user must enter the password assigned by the 
administrator at the first login and assign a new password where applicable. Every login, 
whether successful or not, generates an entry in the Audit Trail of the Reporting Software. 

Logout as user: 
The logout can take place in different ways: 

- By closing the Reporting Software 

- By selecting "File -> Logout" 

- By selecting "File -> Login under another user name..." 

Every logout, whether successful or not, generates an entry in the Audit Trail of the 
software. 
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6 Device Settings dialog 

Settings that are assigned directly to a device can be defined using the setting menu. To do 
so, in the Task Pane, select the corresponding device under "Data Management -> Plant 

View", then open the settings window by clicking the "Wrench" icon  or selecting 
"Change settings ..." from the context menu that appears when you right-click: 
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6.1 Communication Settings  

The Communication Settings of the devices are defined during the first read-out process. 
You can change already defined Communication Settings in the setting menu. 

The setting of the communication depends on the selected communication type and thus 
on the field device connected. 
In the first step, select the type of communication with the field device in the top area, 
"Select Source". The device type is defined by default through the selection of the device in 
the Plant View. 

After selecting the communication type, define the communication parameters in the 
lower area. 
To confirm and save the Communication Settings, you have to exit the menu using the "OK" 
button. 

 

Communication types and Communication Settings: 

Serial interface: For serial communication (RS232/485, etc.), configure the specified 
parameters.  

"Automatic": All available serial interfaces are scanned, thus providing automatic detection 
of the connected device and the necessary communication settings. 

"Manual": Define the communication parameters manually and enter them into the 
specified fields. 
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Modem: Enter the communication parameters into the specified fields. In some cases, 
these are provided in the documentation of the modem and from the wireless provider. 

 

 

Ethernet: Enter the Ethernet communication parameters manually into the specified 
fields. For detailed information such as the port number, contact your system 
administrator. 
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USB: You can usually keep the default USB setting. If necessary, change the parameters 
"Device address" and "Readout ID" manually. 

 

 

6.2 Database Information  

The database information in the device dialog provides information on the device data and 
on the amount of data that has been read out of the device and imported into the 
database: 

 

Name: Name of the device 

Firmware version: Firmware version of the device 

Order code: Order code of the device - identifies the device with the ordered and delivered 
options  

Order identifier: Number identifying the device, order and customer 

Database size: Size of the device data that are stored in the SQL database. 

Additional device information can be accessed via the Endress+Hauser W@M portal using 
the order code and the order ID. This is relevant for device management over the entire 
life cycle of the plant. 
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6.3 Automatic – Read out device   

The function for automatic data read out is enabled/disabled in the setting menu: 

 

Details see chapter 4.4 “Data Management –> Automatic”  

Active: Enables or disables the “Data readout” automatic function. 

Interval: Select the interval for this automatic function.  
Options: Minutely, hourly, daily, weekly, monthly 

Repeat every (only if minutely or hourly is selected for the interval): select the time lag for 
the automatic function of the selected interval.  

Start day (only if weekly or monthly is selected for the interval): select the day of the week 
for the automatic function of the selected interval. 

Start time (only if daily, weekly or monthly is selected for the interval): select the starting 
time for the automatic function of the selected interval. 

Additional batch triggered:  
Selection only possible for the following Automatic functions: Read out device, Print out 
template, Xls/Csv Export and Pdf Export, if batch data is available. As soon as the batch 
job is completed the Automatic function is carried out.  
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6.4 Automatic – Delete data  

Caution! Once data is deleted, this cannot be undone! Ensure that data that are deleted 
from the unit / device are really no longer needed, or have already been saved to another 
storage location as a secure export so that they are available later if needed. 

The function for automatic data elimination is enabled/disabled in the setting menu: 

 

Active: Enables or disables the “Data elimination” automatic function. 

Interval: Select the interval for this automatic function.  
Options: Minutely, hourly, daily, weekly, monthly 

Repeat every (only if minutely or hourly is selected for the interval): select the time lag for 
the automatic function of the selected interval.  

Start day (only if weekly or monthly is selected for the interval): select the day of the week 
for the automatic function of the selected interval. 

Start time (only if daily, weekly or monthly is selected for the interval): select the starting 
time for the automatic function of the selected interval. 

Time slot: Select the time slot for deleting the data. The data of the set time is not deleted.  

Example:  
Interval: Daily; start time: 23:59:00; time slot: 0 day 00:09:00 
The data is deleted daily at 23:59. The data of the last 9 minutes are retained in the 
memory. 
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6.5 Automatic - Time synchronize  

Here, you can automatically synchronize the device time with the system time of the 
computer. The automatic function for time synchronization is enabled/disabled in the 
setting menu: 

 

Active: Enables or disables the “Time synchronize” automatic function. 

Interval: Select the interval for this automatic function.  
Note! The possible options for the interval depend on the device. 

Repeat every (only if minutely or hourly is selected for the interval): select the time lag for 
the automatic function of the selected interval.  

Start day (only if weekly or monthly is selected for the interval): select the day of the week 
for the automatic function of the selected interval. 

Start time (only if daily, weekly or monthly is selected for the interval): select the starting 
time for the automatic function of the selected interval. 

Tolerance: Select the tolerance for time synchronization. If the system time between the 
device and computer differs by more than the tolerance set here the time is not 
synchronized.  
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6.6 Automatic – Binary Export  

The function for automatic data backup is enabled/disabled in the setting menu: 

 

Active: Enables or disables the "Data backup" automatic function. 

Interval: Select the interval for this automatic function.  
Options: Minutely, hourly, daily, weekly, monthly 

Repeat every (only if minutely or hourly is selected for the interval): select the time lag for 
the automatic function of the selected interval.  

Start day (only if weekly or monthly is selected for the interval): select the day of the week 
for the automatic function of the selected interval. 

Start time (only if daily, weekly or monthly is selected for the interval): select the starting 
time for the automatic function of the selected interval. 

Data time period: Select the time period of the data to be backed up  
(e.g.: "0 day 10:00:00" saves the data of the last 10 hours).  

File path: The file storage location is defined here. Clicking the "..." button opens the menu 
structure of the computer and you can select the storage location. 

File Path: Here the storage location is defined. The button “...” opens the menu structure 
of the computer and the storage location can be selected. 
If a network drive is selected a user and password request is prompted. The current setting 
will be saved and can be changed under “Extras -> Settings -> Automatic” (see chapter 
5.1.6). 

Note!  
A new file is created each time a backup copy of the data is created. The time stamp with 
the format "year-month-day h-m-s" is automatically added to the file name  
(e.g.: automatic_test_ 2010-06-25 08-09-30.fdm). 
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7 Troubleshooting 

7.1 System error messages 

Error messages at “Read Out“: 

 
Error key Problem, cause Remedy 

0x20000001 During the read out of the data an internal error occurred. Please try again. 

0x20000002 The access to the data file is not possible. Please check the file path. 

0x20000003 The access to the data is not possible. Please check your access rights. 

0x20000004 The connection to the device could not be established.  Please try again. 

0x20000005 During the communication with the device an error occurred.  Please try again. 

0x20000006 The communication settings are not correct.  Please check the settings. 

0x20000007 During the communication with the device an error occurred.  Please try again. 

0x20000008 During the communication with the device an error occurred.  Please try again. 

0x20000009 During the communication with the device an error occurred.  Please try again. 

0x2000000A The connected device is not supported. Please select a different device. 

0x2000000B During the communication with the device an error occurred.  Please try again. 

0x2000000C The configured device address is not correct.  Please check the configuration. 

0x2000000D The connection to the device is broken down.  Please try again. 

0x2000000E No device can be found on the configured interface.  Please check the connection and the interface 
settings. 

0x2000000F During the communication with the device an error occurred.  Please try again. 

0x20000010 The configured IP address or host cannot be reached.  Please check the settings. 

0x20000011 The specified COM port is already used by another application Please check the connection settings. 

0x20000012 The specified COM port is not available. Please check the connection settings. 

0x20000013 The data are damaged and cannot be read in the database Please inform the support level. 

0x20000014 The configured file path does not exist. Please check the file path. 

0x20000015 No data available for the specified time range. Please select a different time range. 

0x20000016 The data are stored by an unknown type of device. The data 
cannot be read in. 

Please inform your support level. 

0x20000017 The connected modem could not be initialized.  Please check the connection to the modem and try 
again. 

0x20000018 The connected modem does not reply.  Please check the connection and the settings. 

0x20000019 General modem error. Please try again. 

0x2000001A The connection to the device is temporarily not possible 
because all communication channels of the device are busy.  

Please try again later. 

0x20000020 There is already a read out process running.  Please check the manual and automatic configuration.   

0x20000021 There are no more device data available. Please try again a little bit later. 

0x20000022 There is already a read out process running. Please check the manual and automatic configuration.   

0x20000023 Error during device clock synchronization. Some devices are 
limited how often the device time can be set. 

Please try it later again. 

0x20000024 A different device was found. Please check the selected device type. 

0x20000025 Unsupported mass storage format found. Please update your reporting software. 

 

Error messages at the automatic service: 

 
Error key Problem, cause Remedy 

0x40000000 
The automatic service and the tray icon application are not 
installed. 

Please install the automatic components. 

0x40000001 The automatic service of the reporting software is stopped. Please start the automatic service. 

0x40000002 In the automatic service an error occurred. Please check the automatic settings. 

0x40000003 An error occurred during the automatic read out. Please check the automatic settings. 

0x40000004 During the import of the data an error occurred. Please check the automatic settings. 

0x40000005 An error occurred during automatic delete of data. Please check the automatic settings. 

0x40000006 
The communication between service and tray icon is not 
possible. 

Please inform the support level. 

0x40000007 An error occurred during automatic export of binary data. Please check the automatic settings. 

0x40000008 An error occurred during automatic export of xls or csv data. Please check the automatic settings. 
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Error messages at Database Access: 

 
Error key Problem, cause Remedy 

0x60000000 An error occurred during database access! Please check the configuration of the database. 

0x60000001 Error during database access Please check the configuration of the database. 

 

Error messages at User administration: 

 
Error key Problem, cause Remedy 

0x60010000 User account is disabled. Please contact the administrator. 

0x60010001 This user is not an administrator user.  An administrator user is required to perform this action. 
Please contact the administrator. 

0x60010002 Administrator user required An administrator user is required to perform this action. 
Please contact the administrator. 

0x60010003 The password was not changed because the new password 
has not been accepted.  

Please use another password. 

0x60010004 Changing of password failed. Please use another password. 

0x60010005 Deleting the user was not successful.  Please try again. 

0x60010006 The user administration cannot be activated because no 
administrator is configured.  

Please create an administrator user in the user 
administration. 

0x60010007 User account is locked after {0} invalid entered passwords. Please contact the administrator. 

0x60010008 User account is locked after {0} invalid entered passwords 
for 10 minutes. 

Please try again after 10 minutes. 

0x60010009 Login failed.  Please Check User ID and password and try again. 

0x60010010 User Id or Password is wrong.  Please try again. 

0x60010011 Password has expired.  A new password is required. 

0x60010012 It is not possible to delete all administrator users as long as 
'user administration' is activated! 

Please disable the user administration first. 

0x60010013 Current logged on user cannot be deleted.  To delete this user please log in with a different 
administrator account or disable the user administration 
in the option page. 

0x60010014 At least one administrator user should exist as long as 'user 
administration' is activated! 

Please configure an administrator in the user 
administration. 

0x60010015 The new password and password acknowledgement are 
different.  

Please enter both again! 

0x60010019 New password must be different to the last {0} passwords. Please enter a different password. 

0x60010020 Password must contain at least {0} characters. Please enter a different password. 

0x60010021 Password must contain at least 5 characters. Please enter a different password. 

0x60010022 Password must contain numbers. Please enter a different password. 

0x60010023 Password must contain special characters. Please enter a different password. 

0x60010024 Password must contain upper and lower case letters. Please enter a different password. 

0x60010025 No more users can be added. The reporting software only 
allows the maximum number of 50 users.  

Please delete unused users in the user administration 
first. 

0x60010027 This User ID is already used.  Please choose another User ID. 

0x60010028 User administration cannot be activated because there is no 
user with administrator rights set up in the database. 

Please configure an administrator in the user 
administration. 

0x60010032 You don‟t have the rights to change database settings. The 
database settings have not been changed. 

Please contact the administrator. 

 

Error messages at Read out data/Data management: 

 
Error key Problem, cause Remedy 

0x60020000 The import was not successful. The following files are 
damaged: '{0}' 

Please check the file and try again. 

0x60020001 Database access failed. 
Failed to store the following files: {0} 

Please try again. 

0x60020002 Finished with errors.  
Failed to store the following files: {0} 

Please try again. 

0x60020003 The read out was not successful. The connection to the 
device could not be established.  

Please try again. 
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0x60020004 The read out was not successful. No new device could be 
created in the database because the current user does not 
have enough access rights. The following file could not be 
imported: '{0}' 

Please check your access rights. 

0x60020005 The configurations '{0}' and '{1}' could not be merged, 
because data would be lost. 

Please try again or choose different configurations. 

0x60020006 The configurations could not be merged, because 
configuration '{0}' overlaps in time with configuration '{1}'. 

Please try again or choose different configurations. 

0x60020007 Could not connect to database server! Please check the settings. 

0x60020008 Could not connect to database server by using the new 
settings. Changes to the database settings will not be 
applied! 

Please check the settings. 

0x60020009 Invalid database settings Please check the settings. 

0x60020010 Deleting mass storage files was not successful. Please delete manually. 

0x60020011 Delete data in device was not successful. Please delete manually. 

0x60020012 The connection to the device could not be established.  Please check the settings and try again. 

0x60020013 The devices could not be merged, because device '{0}' and 
device '{1}' are from different device types. 

Please select two devices with same type. 

0x60020014 The devices could not be merged, because device '{0}' 
overlaps in time with device '{1}'. 

Please select two devices which don't overlap in time. 

0x60020015 The new node could not be created.  Please try again. 

0x60020016 Add node failed Please try again. 

0x60020017 Adding a new node was not possible. Please logon with a higher user role (e.g. 
administrator). 

0x60020018 Add node Please logon with a higher user role (e.g. 
administrator). 

0x60020019 Deleting the selected node is not allowed. Please logon with a higher user role (e.g. 
administrator). 

0x60020020 Delete node Please logon with a higher user role (e.g. 
administrator). 

0x60020021 Moving the selected node is not allowed. Please logon with a higher user role (e.g. 
administrator). 

0x60020022 Move node Please logon with a higher user role (e.g. 
administrator). 

0x60020023 Renaming the selected node is not allowed. Please logon with a higher user role (e.g. 
administrator). 

0x60020024 Rename node Please logon with a higher user role (e.g. 
administrator). 

0x60020025 Could not create a new node. Please check the settings. 

0x60020026 Creation of node failed. Please check the settings. 

0x60020027 Could not delete the selected node. Please check the settings. 

0x60020028 Delete node failed. Please check the settings. 

0x60020029 Delete node failed. Try again. Maybe you have to extend the timeout for 
the database connection. 

0x60020030 Could not delete the selected node.  Try again. Maybe you have to extend the timeout for 
the database connection. 

0x60020032 An error occurred during import. Could not import {0} out of 
{1} data rows! 

 

0x60020034 Could not move the selected node. Please check the settings. 

0x60020035 Moving of node failed. Please check the settings. 

0x60020036 Could not open the file '{0}'! Please check that the file is readable. 

0x60020037 Could not refresh the plant view. Please check the settings. 

0x60020038 Refresh failed Please check the settings. 

0x60020039 Could not refresh the template view. Please check the settings. 

0x60020040 Refresh failed Please check the settings. 

0x60020041 Could not rename the selected node.  Please make sure that the node name does not extend 
30 characters. 

0x60020042 Renaming of node failed. Please make sure that the node name does not extend 
30 characters. 

0x60020043 Could not update the online interface settings. Please check the settings. 

0x60020044 Update online settings failed. Please check the settings. 

0x60020045 Could not connect to database server. Schema was not 
created! 

Please check the settings. 

0x60020046 Invalid communication settings.  Please press "Back" and select different settings. 

0x60020047 Merging of configurations failed. Please try again or choose different configurations. 

0x60020048 Merging of devices failed. Please try again or choose different devices. 

0x60020049 No communication settings available for the currently 
selected device. 

Please change the communication settings for the 
selected device. 

0x60020050 No files with stored data could be found. Please choose a different directory. 
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0x60020051 An error occurred during readout of the device information.  Please check the connection to the device and try again. 

 

Error messages at the Export: 

 
Error key Problem, cause Remedy 

0x60030000 Finished with errors. Click 'Close' to close the wizard. Please try again.  

0x60030001 Finished with errors. The data have been exported but it was 
not possible to delete the data in the database. 

Click 'Close' to close the wizard.  

0x60030002 The database contains no data for the selected time slots. 
No file was created. 

Please select a valid time slot. 

0x60030003 The selected template contains device(s) which are not 
available in the database. 

Please delete the template. 

0x60030004 Missing devices Please delete the template. 

0x60030005 The selected visualization template contains at least one 
device that does not exist in the database anymore. 

Please delete the template. 

0x60030006 Missing device Please delete the template. 

0x60030007 The selected visualization template does not exist in the 
database anymore. Probably it was deleted in the meantime. 

Please select a different template. 

0x60030008 Visualization template not available Please select a different template. 

0x60030009 You are not able to use this template because you are 
missing access rights for at least one device in the template.  

Please contact the administrator of the reporting 
software. 

0x60030010 No access right Please contact the administrator of the reporting 
software. 

 

Error messages at Import: 

 
Error key Problem, cause Remedy 

0x60040000 The binary export file has been exported with a higher 
software version. The file cannot be imported. 

Please update the reporting software to the actual 
version. 

0x60040001 Finished with errors. No data have been imported. Please check the import file. Click 'Close' to close the 
wizard. 

0x60040002 Finished with warnings. Some data could not be imported. Click 'Ok' to close the wizard. 

0x60040003 The file for import does not contain data. No data have been 
imported into the database.  

Please check the import file. 

 

Error messages at Visualization: 

 
Error key Problem, cause Remedy 

0x60050000 The automatic changes cannot be saved because the 
Template was not saved! 

Please save the template. 

0x60050001 An error occurred during saving of the template. Template 
was not saved in the database. 

Please check the database settings. 

0x60050002 Error during saving of template Please check the database settings. 

0x60050003 An error occurred during export. Export was not successful. Please check the disc space of the selected directory and 
ensure that you have write access to this directory. 

0x60050004 Minimum value must be smaller than "Maximum" value! Please check the selection. 

0x60050005 For the selected time period no data are available in the 
database.  

Please select another time period. 

0x60050006 No data available Please select another time period. 

 

Error messages at installation and database: 

 
Error key Problem, cause Remedy 

0x60060000 The test time of the demo version is elapsed. You cannot 
start this application anymore.  

Please order a serial number for the full version. 

0x60060001 Demo version expired Please order a serial number for the full version. 

0x60060002 The license information is invalid.  Please rerun the installation program. 

0x60060003 License information invalid Please rerun the installation program. 



7 Troubleshooting 

 96 

0x60060004 The new language setting will be activated after the 
application was restarted. 

Please rerun the reporting software. 

0x60060005 Language changed Please rerun the reporting software. 

0x60060006 The currently connected database server does not contain a 
valid database or the database has a wrong version.  

Please contact your administrator. 

0x60060007 Wrong database Please contact your administrator. 

 

Error messages at printing: 

 
Error key Problem, cause Remedy 

0x60070000 The document needs more than 1000 pages. Please choose a smaller period to avoid this problem. 

0x60070001 The document creation was stopped after 1000 pages 
because the maximum number of pages is reached. 

Please choose a smaller period to avoid this problem. 

 



8 Index 

 97 

8 Index 

Audit trail ............................................................... 79 
Automatic ........................................................ 63, 77 
Automatic – Binary Export ................................... 91 
Automatic – Delete data ....................................... 89 
Automatic – Read out device ................................ 88 
Automatic - Time synchronize ............................. 90 
Chart ................................................................. 30, 36 
Communication Settings ....................................... 85 
Configure Automatic ....................................... 23, 51 
Configure Online Interface ................................... 22 
Create a new device ............................................... 21 
Data Management ................................................ 41 
Data Management -> Export ................................ 47 
Data Management -> Import ............................... 60 
Database ................................................................ 74 
Database Information ........................................... 87 
Device information ................................................ 24 
Device Settings....................................................... 84 
Disclaimer of liability ............................................... 7 
Edit Template ........................................................ 37 
Energy monitoring ................................................ 53 
Export ..................................................................... 74 
Export in insecure format (ExcelTM/CSV, Energy 

monitoring) ................................................... 53 
Export of binary files (*.fdm) ............................... 48 
Exporting Data ....................................................... 52 
Extras ..................................................................... 73 
General ................................................................... 78 
Hardware and software requirements .................... 8 
Installation ............................................................. 10 
Introduction .............................................................. 6 
Language................................................................ 73 

Merge Configurations ............................................ 43 
Merge Devices ........................................................ 46 
Merging .................................................................. 45 
Plant View ............................. 11, 18, 21, 27, 38, 41 
Preface ...................................................................... 6 
Printer ..................................................................... 76 
Program Logbook ................................................. 33 
Read Data ............................................................... 17 
Read out data ............................................ 14, 20, 25 
Read out data -> Mass storage ............................. 15 
Read out data -> Online Connection .................... 18 
Result 

Merge Devices ..................................................... 47 
Safety instructions ................................................... 7 
Sampler ................................................................... 33 
Select channels ....................................................... 39 
Select Channels ............................................... 28, 35 
Select Configurations ............................................. 43 
Select Data Source .................................................. 15 
Select Device .................................................... 16, 38 
Select device already created ................................. 18 
Select Devices .................................................. 27, 46 
Select Template ............................................... 35, 37 
Select Time Slot ............................................... 29, 36 
Select Usage of Template ...................................... 54 
Settings ................................................................... 73 
Tray Icon ................................................................. 71 
Updating template ................................................. 40 
User administration ........................................ 75, 80 
Visualization ........................................................... 26 
Visualization  -> New ............................................ 27 
Visualization  -> Open ........................................... 35 

 

 



8 Index 

 98 



8 Index 

 99 



                                                Products  Solutions                                                         Services                                       

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

www.endress.com/worldwide


